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Abstrak 

Perkembangan dibidang otomasi sangat pesat, khususnya pada dunia medis. Dalam 
dunia medis infus merupakan alat yang paling sering digunakan. Fungsi infus sendiri 
adalah untuk memberikan cairan kepada pasien secara berkala. Pada saat ini, 
pemeriksaan cairan infus pada pasien masih dilakukan secara manual, sehingga apabila 
terjadi masalah seperti penyumbatan atau kehabisan cairan akan berbahaya bagi pasien 
jika tidak segera ditangani. Penelitian ini dilakukan untuk mengatasi keterlambatan 
tersebut. Oleh sebab itu, pada penelitian ini dibuatlah sistem pemantau cairain infus 
berbasis NodeMCU yang merupakan pengendali sistem atau pengelola informasi. Sistem 
ini terdiri dari dua bagian yaitu bagian transmitter pada kamar pasien dan bagian receiver 
di ruang perawat. Pembuatan alat monitoring tetesan infus ini terdiri dari beberapa 
tahapan yaitu identifikasi kebutuhan, analisis kebutuhan, blok diagram rangkaian, 
perencanaan sistem, langkah pembuatan alat, flowchart program, pengujian alat dan 
pengambilan data. Alat ini menggunakan sensor photodioda yang berfungsi dalam 
mendeteksi kondisi level cairan infus. Hasil pembacaan kondisi level cairan infus akan 
dikirim ke database bernama firebase yang selanjutnya akan di informasikan kepada 
user atau perawat melalui aplikasi yang telah di instal pada android. Apabila kondisi 
cairan infus hampir habis maka buzzer yang berfungsi sebagai alarm akan aktif.  
 
Kata Kunci: Level Cairan Infus, NodeMCU, Sensor Photodioda, Database, Buzzer. 
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1. PENDAHULUAN 
Cairan infus adalah air yang dimurnikan lewat proses penyulingan. 

Pemberian cairan melalui infus merupakan tindakan memasukkan cairan melalui 
intravena untuk memenuhi kebutuhan cairan dan elektrolit serta sebagai tindakan 
pengobatan dan pemberian makanan. Cairan infus juga digunakan sebagai 
larutan awal bila status elektrolit pasien belum diketahui, misal pada kasus 
dehidrasi karena asupan nutrisi tidak memadai, demam, dan lain-lain. Fungsi 
infus sangatlah penting bagi pasien, maka proses pemasangan infus harus 
dilakukan dengan benar untuk menghindari timbulnya komplikasi yang dapat 
mempengaruhi keadaan pasien.  

Selain itu, pengontrolan dan pemantauan penggunaan cairan infus harus 
dilakukan oleh perawat pada rumah sakit/klinik/puskesmas dengan benar, 
dimana perawat harus memeriksa satu-persatu kondisi infus pasien secara 
berkala. Keterbatasan waktu, jarak antara ruang pasien dan monitoring room 
serta keterbatasan jumlah tenaga medis di rumah sakit/puskesmas dapat 
menyebabkan pasien terlambat ditanggulangi. Apabila infus habis, perawat 
diharuskan segera menggantinya dengan yang baru, dan kondisi seperti inilah 
yang sering terlambat ditanggulangi oleh perawat. Keterlambatan perawat dalam 
penggantian cairan infus dapat memberikan dampak negatif terhadap pasien 
dengan terjadinya komplikasi seperti darah pasien tersedot naik ke selang infus 
dan dapat membeku pada selang infus, sehingga mengganggu kelancaran aliran 
infus.  

Selain itu, jika tekanan pada infus tidak stabil, darah yang membeku pada 
selang infus dapat tersedot kembali masuk ke dalam pembuluh darah. Darah 
yang membeku (blood clot) tersebut dapat beredar ke seluruh tubuh dan dapat 
menyumbat kapiler darah di paru-paru sehingga menyebabkan emboli di paru-
paru. Jika berbagai hal tersebut terjadi maka tempat pemasangan infus harus 
dipindahkan dan dipasang ke pembuluh darah vena lain, yang tidak menutup 
kemungkinan dapat menyebabkan timbulnya berbagai komplikasi yang jauh lebih 
berbahaya akibat pemasangan yang tidak dilakukan dengan benar. Berdasarkan 
permasalahan tersebut, maka penulis membuat alat yang dapat memantau sisa 
cairan infus dan mengendalikan aliran infus pada pasien.  

Sensor dipasang pada botol infus untuk mendeteksi sisa cairan infus, data 
keadaan infus akan dikirim ke mikrokontroler untuk diproses. Hasil proses 
dikirimkan melalui transmitter dan diterima oleh receiver untuk ditampilkan pada 
android yang terhubung dengan internet. Apabila cairan infus berada pada 
kondisi yang telah ditetapkan maka akan ada tanda peringatan pada sensor 
photodioda untuk menghentikan aliran infus pada selang infus. 
 
2. METODE PENELITIAN 

Jenis penelitian yang digunakan adalah penelitian kualitatif dengan metode 
eksperimental. Dipilihnya jenis penelitian ini karena penulis menganggap jenis ini 
sangat cocok dengan penelitian yang diangkat oleh penulis karena melakukan 
pengembangan sebuah alat dan melakukan penelitian berupa ekseperimen 
terhadap objek penelitian penulis. Adapun lokasi penelitian dan perancangan alat 
dilakukan di Fakultas Teknik UMSU. 

Pada proses perancangan perangkat keras dilakukan dengan menggambar 
rancangan dari setiap masing-masing rangkaian yang akan digabungkan dengan 
board mikrokontroller NodeMCU. Adapun proses perancangan ini menggunakan 
peralatan solder kabel dan timah untuk menggabungkan komponen-komponen 
pendukung NodeMCU. Pada rangkaian ini terdapat hardware secara 
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keseluruhan yang masing - masing telah terhubung pada mikrokontroller. 
Rangkaian keseluruhan dapat dilihat pada gambar berikut : 

 
Gambar 1. Rangkaian Keseluruhan 

Sistem Pada gambar, dapat dilihat bahwa NodeMCU adalah otak dari 
seluruh rangkaian yang mendapat supply tegangan dari adaptor 12V DC melalui 
regulator penurun tegangan, regulator berfungsi menurunkan tegangan dari 
adaptor 12V DC menjadi 5V DC untuk dapat memberi tegangan pada NodeMCU 
yang hanya mampu beroperasi apabila diberi tegangan 5V DC dan setelah 
NodeMCU aktif maka NodeMCU dapat membaca tegangan pada seluruh 
rangkaian untuk dapat menjalankan perintah yang telah diisikan kedalam 
mikrokontroller tersebut. 
 
3. HASIL 
Prosedur Kerja Sistem Pemantau Level Cairan Infus  
Prosedur kerja dari sistem pemantau level cairan infus adalah sebagai berikut:  
a. Langakah pertama untuk sistem kerja dari alat ini adalah, operator harus 

menghubungkan sistem data base dan android ke jaringan internet.  
b. Jika sistem sudah terhubung dengan jaringan internet, operator melakukan 

pemrograman dengan menggunakan arduino IDE.  
c. Setelah proses pemrograman berhasil, maka operator dapat mengaktifkan 

saklar yang terdapat pada box hitam yang melekat pada tiang infus, dan 
secara otomatis sistem akan bekerja.  

d. Sensor akan membaca kondisi cairan infus yang berada di depannya. 
Sensor 1 akan mendeteksi cairan infus dan mengirim data ke NodeMCU. 
Selanjutnya NodeMcu akan menyimpan data tersebut dan mengirimnya ke 
data base firebase, sehingga pada aplikasi yang terdapat di android. 
menampilkan informasi berupa “High Level” yang berarti air infus dalam 
kondisi penuh. Dan begitu juga sebaliknya untuk kerja dari sensor 2 dan 3. 
Untuk sensor 2 pada layar android akan menampilkan informasi “Medium 
Level” yang berarti air infus hampir habis. Dan untuk sensor 3 pada layar 
android akan menampilkan informasi “Low Level” yang berarti air infus harus 
diganti.  

e. Pada saat kondisi air infus berada di posisi low level maka secara otomatis 
buzzer yang merupakan alarm akan aktif yang menandakan perawat harus 
segera menggati air infus pasien. 
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Upload Program Pada NodeMcu Dan Database  
Berikut cara yang dapat dilakukan untuk melakukan setup board NodeMCU 

dengan menggunakan arduino IDE adalah sebagai berikut:  
1. Hal pertama yang harus dilakukan adalah mendownload aplikasi arduino 

IDE. 
2. Setelah melakukan download dan instal selanjutnya adalah menginstal 

board ESP8266 pada arduino IDE. Berikut cara menambahkan board 
ESP8266 pada arduino IDE:  
a. Buka software arduino IDE  
b. Lalu buka menu File → Preferences. Setelah tab preference terbuka, 

pada menu Additional Boards Managers URLs isikan script 
“http://arduino.esp8266.com/stable/package_esp8266com_index.j son” 
setelah itu klik Ok.  

c. Buka menu Tools → Board → Boards Manager. Tunggu hingga aplikasi 
mengambil repository dari link yang sudah kita masukan tadi. Setelah 
selesai ketikan ESP8266 pada kolom pencarian, setelah ditemukan klik 
install lalu tunggu hingga proses installasi board selesai.  

d. Setelah proses installasi selesai, buka menu Tools → Board, lalu cari 
dan pilih board NodeMcu 1.0 (ESP-12E Module).  

e. Setelah proses instal selesai maka kita bisa menemukan board bernama 
NodeMcu di submenu board.  

3. Selanjutnya hubungkan NodeMcu ke komputer.  
4. Kemudian kita dapat mencoba upload program pada NodeMcu, sesuai 

dengan program yang telah dibuat berdasarkan projek penelitian.  
5. Setelah muncul 100% berarti program sudah berhasil di upload, dan kita 

dapat memastikan pada perangkat laptop maupun smartphone, apakah 
modul NodeMcu sudah menjalankan program yang kita upload dengan baik 
dan sesuai. 

 
Adapun langkah - langkah untuk melakukan konfigurasi firebase realtime 

database adalah sebagai berikut:  
1. Login ke web firebase.com kemudian masuk ke console.  
2. Lalu buat project baru dengan nama data alex.  
3. Setelah membuat project baru kemudian akan ditampilkan halaman console 

untuk pengaturan firebase.  
4. Untuk melakukan komunikasi antara NodeMcu dengan realtime database 

firebase dibutuhkan alamat host dan key project firebase. Pada halaman 
console pilih Database. Host link database pada project di tunjukkan pada 
link “data-alex.firebaseio.com”.  

5. Untuk membuat key database melalui menu project setting kemudian pilih 
Tab Service Account. Setelah itu pilih Database Secrets. Untuk 
mendapatkan key database klik tombol show sehingga key database dapat 
terlihat kemudian copy key tersebut. 

6. Pada proses konfigurasi Firebase sudah didapatkan 2 buah konfigurasi yang 
pertama adalah alamat host dan yang kedua adalah key database.  

 
Berikut tahapan untuk menginstal library firebase:  

1. Pada saat memrogram NodeMcu yang mampu berkomunikasi dengan 
firebase digunakan library firebase ardunio.  

2. Library firebase untuk arduino dapat diunduh di alamat 
github.com/firebase/firebase-arduino → pilih Clone or Download. File 
download berexstensi *.zip.  
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3. Setelah download dilanjutkan dengan instalasi library ke arduino IDE melalui 
menu add file (Sketch → Add File...) kemudian pilih file yang sudah di 
download sebelumnya. Apabila sudah berhasil ddidalam menu Include 
Library (Sketch → Include Library) sudah terdapat menu Firebase Arduino. 

 
4. PEMBAHASAN 
Pengujian Aplikasi Pada Smartphone Android  

Pengujian sistem ini dilakukan dengan cara mengirim data yang terdapat di 
firebase kepada android. Data yang dikirim akan ditampilkan pada aplikasi yang 
telah diinstal di android yang bernama kodular, yang berfungsi untuk memberikan 
informasi kepada user atau perawat untuk mengetahui kondisi cairan infus 
pasien. Berikut tampilan monitoring level cairan infus pada android untuk masing-
masing kondisi. 

 
Gambar 1. Kondisi Cairan Infus Pada Posisi High Level 

 

Pada gambar diatas menunjukkan kondisi cairan infus pada posisi high level. 
Pada kondisi ini cairan infus dalam keadaan penuh, dimana tampilan indikator 
untuk tiap-tiap level dalam keadaan aktif semua. Indikator untuk posisi high level 
berwarna hijau, medium level berwarna kuning dan low level berwarna merah. 

 
Gambar 2. Kondisi Cairan Infus Pada Posisi Medium Level 
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Gambar diatas merupkan tampilan kondisi cairan infus pada posisi medium 
level di android. Pada kondisi medium level, tampilan indikator berwarna kuning. 
Oleh karena kondisi cairan infus semakin lama semakin berkurang makan 
indikator berwarna hijau yang merukapan posisi high level akan semakin redup. 

 
Gambar 3. Kondisi Cairan Infus Pada Posisi Low Level 

 
Gambar diatas merupakan tampilan kondisi cairan infus pada posisi low level 

yang ditandai dengan indikator berwarna merah. Pada kondisi ini semakin lama 
air infus akan semakin berkurang dan harus diganti, yang ditandai dengan 
tampilan indikator high level dan medium level semakin redup . Pada posisi ini 
buzzer yang berfungsi sebagai alarm kepada perawat akan aktif dan pada saat 
itu juga perawat harus mengganti cairan infus pasien dengan cairan infus yang 
baru. Adapun list program dari pengujian firebase adalah: 

 
Gambar 4. list program dari pengujian firebase 

 
 



Jurnal Ilmiah Mahasiswa Teknik [JIMT] 

Volume 2 Nomor 6 Juni 2022 Hal 477 - 486 

ISSN: 2808-7720 

 

483 
Jurnal Homepage: http://jurnalmahasiswa.umsu.ac.id/index.php/jimt 

5. KESIMPULAN 
Berdasarkan dari hasil pembuatan rancangan dan pengujian hasil alat 

rancangan maka dapat disimpulkan:  
1. Telah terealisasi suatu sistem pemantau level cairan infus menggunakan 

NodeMCU dan sensor photodioda sebagai upaya untuk mengatasi 
keterlambatan perawat dalam memberikan cairan kepada pasien.  

2. Perancangan alat yang dibuat dalam pelaksanaannya dapat mengatasi 
naiknya darah ke selang infus, mengetahui kondisi level cairan infus dan 
mempermudah perawat dalam melakukan tugasnya.  

3. Proses internet of things pada monitoring berhasil di lakukan, ini di buktikan 
dengan dapat di gunakannya internet untuk pengamatan secara terus 
menerus pada kondisi infus di lapangan. 

 
REFERENSI 
Adam, M., & Zurairah, M. (2021, August). PERANCANGAN PENGENDALI SUHU 

RUANGAN KELAS DI UNIVERSITAS MUHAMMADIYAH SUMATERA UTARA. 
In Seminar Nasional Teknik (SEMNASTEK) UISU (Vol. 4, No. 1, pp. 80-89). 

Adam, M., Harahap, P., Oktrialdi, B., & Herlambang, R. (2021). Analisis Pengasutan 
Motor Induksi Menggunakan Softstarter dan Inverter. Jurnal MESIL (Mesin Elektro 
Sipil)/Journal MESIL (Machine Electro Civil), 2(2), 81-87. 

Adam, M. (2015). Manajemen Pemasaran Jasa: teori dan aplikasi. 
Adam, M. (2020). Pengaruh kondisi pemotongan proses freis baja s45c terhadap 

temperatur pahat, geram, benda kerja. SKRIPSI-2020. 
Asmara, I. P. S., & Adam, M. (2021, August). Seakeeping and resistance analysis of 

1200 GT passenger ship fitted with NACA 4412 stern foil using CFD method. In IOP 
Conference Series: Materials Science and Engineering (Vol. 1175, No. 1, p. 
012002). IOP Publishing. 

Evalina, N., Pasaribu, F. I., & Azis, A. (2021). The Use of Inverters in Solar Power Plants 
for Alternating Current Loads. Britain International of Exact Sciences (BIoEx) 
Journal, 3(3), 151-158. 

Evalina, N., Azis, A., Pasaribu, F. I., & Arfis, A. (2021, November). Penerapan 
Pembangkit Listrik Tenaga Surya pada Robot Penyemprot Desinfektan. In Prosiding 
Seminar Nasional Kewirausahaan (Vol. 2, No. 1, pp. 368-374). 

Evalina, N., Pasaribu, F. I., & Efrida, R. (2021). Pendampingan Pembuatan Souvenir Dari 
Bahan Resin di Panti Asuhan Putri Aisyiyah Cabang Medan Kota. Jurnal 
Pengabdian Masyarakat, 4(2). 

Evalina, N., Abduh, R., & Arfis, A. (2019, October). Pembuatan Gantungan Kunci Dari 
Bahan Resin di Desa Jaharun A. In Prosiding Seminar Nasional 
Kewirausahaan (Vol. 1, No. 1, pp. 251-256). 

Gomesh, N., Daut, I., Kumaran, V., Irwanto, M., Irwan, Y. M., & Fitra, M. (2013). 
Photovoltaic powered T-shirt folding machine. Energy Procedia, 36, 313-322. 

Harahap, U., & Pasaribu, F. I. (2016). Sistem Kontrol Buka Tutup Valve pada Proses 
Pemanasan Air Jaket (Doctoral dissertation, Universitas Medan Area). 

Harahap, P., & Adam, M. (2021). Efisiensi Daya Listrik Pada Dispenser Dengan Jenis 
Merk Yang Berbeda Menggunakan Inverator. RESISTOR (Elektronika Kendali 
Telekomunikasi Tenaga Listrik Komputer), 4(1), 37-42. 

Harahap, P. H. P., & Al-Ani, W. K. A. (2021). The Effect of Charcoal on the Improvement 
of Grounding Resistance as a Soil Treatment in Reducing Grounding 
Resistance. Journal of Renewable Energy, Electrical, and Computer 
Engineering, 1(1), 12-15. 

Harahap, P., & Oktrialdi, B. (2020, April). Harmonisa in defibrillator equipment (DC 
Shock) using simulink Matlab. In IOP Conference Series: Materials Science and 
Engineering (Vol. 821, No. 1, p. 012025). IOP Publishing. 

Harahap, P., Nofri, I., & Lubis, S. (2021). PLTS 200 Wp to Meet Energy Needs at the 
Taqwa Muhammadiyah Mosque, Sei Litur Village, Sawit Sebrang Langkat 
District. Journal of Innovation and Community Engagement, 1(1), 60-71. 



Jurnal Ilmiah Mahasiswa Teknik [JIMT] 

Volume 2 Nomor 6 Juni 2022 Hal 477 - 486 

ISSN: 2808-7720 

 

484 
Jurnal Homepage: http://jurnalmahasiswa.umsu.ac.id/index.php/jimt 

Harahap, P. (2018, June). REDUKSI HARMONISA PADA PERALATAN X-RAY MOBILE 
100 mA. In SEMNASTEK UISU 2018. 

Harahap, P. (2015). Mereduksi Harmonisa pada Peralatan X-Ray Mobile 100mA dengan 
Menggunakan Filter Pasif (Single Tuned and Double Tuned Passive Filter). 

Harahap, P., & Adam, M. (2021). Efisiensi Daya Listrik Pada Dispenser Dengan Jenis 
Merk Yang Berbeda Menggunakan Inverator. RESISTOR (Elektronika Kendali 
Telekomunikasi Tenaga Listrik Komputer), 4(1), 37-42. 

Harahap, P., & Oktrialdi, B. (2020, April). Harmonisa in defibrillator equipment (DC 
Shock) using simulink Matlab. In IOP Conference Series: Materials Science and 
Engineering (Vol. 821, No. 1, p. 012025). IOP Publishing. 

Harahap, P., Adam, M., & Oktrialdi, B. (2022). Optimasi Kapasitas Rooftop Pv Off Grid 
Energi Surya Berakselerasi di Tengah Pandemi Covid-19 untuk Diimplemtasikan 
pada Rumah Tinggal. RESISTOR (Elektronika Kendali Telekomunikasi Tenaga 
Listrik Komputer), 5(1), 31-38. 

Harahap, P., Oktrialdi, B., & Cholish, C. (2018, December). Perancangan Conveyor Mini 
untuk Pemilahan Buah Berdasarkan Ukuran yang Dikendalikan oleh Mikrokontroller 
Atmega16. In Prosiding Seminar Nasional Teknoka (Vol. 3, pp. E37-E42). 

Hermawan, D., Primasyukra, M. A., Zambak, M. F., & Hardi, S. (2021). Perbandingan 
Tiga Metode Pendekatan Nilai Intensitas Konsumsi Energi (IKE) Di Pondok 
Pesantren. RELE (Rekayasa Elektrikal dan Energi): Jurnal Teknik Elektro, 4(1), 35-
41. 

Hwai, L. J., Zambak, M. F., & Nisja, I. (2016). Assessment of Wind Energy Potential using 
Weibull Distribution Function as Wind Power Plant in Medan, North 
Sumatra. International Journal of Simulation--Systems, Science & 
Technology, 17(41). 

Hutabarat, P. H., & Zambak, M. F. (2021). PENGHEMATAN KONSUMSI ENERGY 
MELALUI ANALISA IKE DI KAMPUS II EFARINA PEMATANGSIANTAR. JOURNAL 
OF ELECTRICAL AND SYSTEM CONTROL ENGINEERING, 5(1), 36-43. 

Hutasuhut, A. A., Riandra, J., & Irwanto, M. (2022, February). Analysis of hybrid power 
plant scheduling system diesel/photovoltaic/microhydro in remote area. In Journal of 
Physics: Conference Series (Vol. 2193, No. 1, p. 012024). IOP Publishing. 

Ismail, R., Hasibuan, A., Isa, M., Abdurrahman, F., & Islami, N. (2019). Mitigation of high 
voltage induction effect on ICCP system of gas pipelines: a field case 
study. TELKOMNIKA (Telecommunication Computing Electronics and 
Control), 17(6), 3226-3231. 

Lubis, S., Pasaribu, F. I., Damanik, W. S., Siregar, M. A., Siregar, I., & Hasibuan, E. S. 
(2020). The Design and Qibla Direction by Using the Hmc 5883 L Sensor as a 
Compass Rhi in the UMSU Science Laboratory (OIF). Budapest International 
Research in Exact Sciences (BirEx) Journal, 2(3), 376-381. 

Lubis, S., & Cholish, C. (2019). Pelatihan Pembuatan Peta Cabang Dan Ranting 
Muhammadiyah Menggunakan Aplikasi Sicara Untuk Mercepatan Pemetaan 
Cabang Dan Ranting Muhammadiyah Se-Kota Medan. RELE (Rekayasa Elektrikal 
dan Energi): Jurnal Teknik Elektro, 2(1), 14-21. 

Muharnif, M., Umuani, K., & Nasution, F. A. (2022). Analisis Termoelektrik Generator 
(TEG) Sebagai Pembangkit Listrik Bersekala Kecil Terhadap Perbedaan 
Temperatur. Jurnal Rekayasa Material, Manufaktur dan Energi, 5(1), 26-32. 

Muharnif, M., & Nasution, E. S. (2018). Pembuatan Hydrofoil Turbin Darrieus. Jurnal 
Sistem Informasi, 2(1). 

Nasution, E. S., Rohana, R., & Lubis, R. F. (2019). PKM Pengembangan Rumah 
Produksi. JURNAL PRODIKMAS Hasil Pengabdian Kepada Masyarakat, 3(1). 

Nasution, E. S. (2010). PENGARUH STRATEGI PEMBELAJARAN DAN GAYA 
BELAJAR TERHADAP HASIL BELAJAR MENGIKUTI PROSEDUR KESEHATAN 
DAN KESELAMATAN KERJA DI SMK AR-RAHMAN MEDAN (Doctoral dissertation, 
UNIMED). 

Nasution, E. S., Pasaribu, F. I., Yusniati, Y., & Arfianda, M. (2019). Rele diferensial 
sebagai proteksi pada transformator daya pada gardu induk. Ready Star, 2(1), 179-
186. 



Jurnal Ilmiah Mahasiswa Teknik [JIMT] 

Volume 2 Nomor 6 Juni 2022 Hal 477 - 486 

ISSN: 2808-7720 

 

485 
Jurnal Homepage: http://jurnalmahasiswa.umsu.ac.id/index.php/jimt 

Nasution, E. S., Zambak, M. F., Suhendra, S., & Hasibuan, A. (2020). Simulasi 
Pengoperasian Motor Pompa Air Berbasis Programmable Logic 
Control. INVENTORY: Industrial Vocational E-Journal On Agroindustry, 1(2), 78-82. 

Nasution, E. S., Pasaribu, F. I., Yusniati, Y., & Arfianda, M. (2019). Rele diferensial 
sebagai proteksi pada transformator daya pada gardu induk. Ready Star, 2(1), 179-
186. 

Nasution, E. S., & Hasibuan, A. (2018). Pengaturan Kecepatan Motor Induksi 3 Phasa 
Dengan Merubah Frekuensi Menggunakan Inverter ALTIVAR 12P. Jurnal Sistem 
Informasi, 2(1). 

Nasution, E. S., Hasibuan, A., & Rifai, M. (2018). Rancang Bangun Alat Penjemur Terasi 
Otomatis Berbasis Microcontroler. Jurnal Sistem Informasi, 2(2). 

Nasution, E. S., Hasibuan, A., Siregar, W. V., & Ismail, R. (2020, September). Solar 
power generation system design: Case study of north sumatra muhammadiyah 
university building. In 2020 4rd International Conference on Electrical, 
Telecommunication and Computer Engineering (ELTICOM) (pp. 191-194). IEEE. 

Nasution, E. S., Hasibuan, A., Siregar, W. V., & Ismail, R. (2020, September). Solar 
power generation system design: Case study of north sumatra muhammadiyah 
university building. In 2020 4rd International Conference on Electrical, 
Telecommunication and Computer Engineering (ELTICOM) (pp. 191-194). IEEE. 

Pasaribu, F. I., Roza, I., & Sutrisno, O. A. (2020). Sistem Pengamanan Perlintasan 
Kereta Api Terhadap Jalur Lalu Lintas Jalan Raya. Journal of Electrical and System 
Control Engineering, 4(1), 43-52. 

Pasaribu, F. I. (2021). BEBAN NON LINIER DAN ANALISA HARMONISA. Jurnal Elektro 
dan Telkomunikasi, 5(1), 29-34. 

Pasaribu, F. I., Roza, I., & Efendi, Y. (2019). Memanfaatkan panas exhaust sepeda motor 
sebagai sumber energi listrik memakai thermoelectric. Journal of Electrical and 
System Control Engineering, 3(1), 13-29. 

Pohan, M. Y., Pinayungan, D., Zambak, M. F., Hardi, S., Suwarno, S., Rohana, R., & 
Warman, E. (2021, March). ANALISA PERANCANGAN PEMBANGKIT LISTRIK 
TENAGA SURYA PADA RUMAH TINGGAL DI PONDOK 6. In Scenario (Seminar of 
Social Sciences Engineering and Humaniora) (pp. 335-341). 

Rimbawati, R., Hutasuhut, A. A., & Muharnif, M. (2018). MODIFIKASI MOTOR INDUKSI 
TIGA PHASA SISA PAKAI INDUSTRI MENJADI HYDROELECTRIC GENERATOR 
UNTUK PLTMH. Kumpulan Penelitian dan Pengabdian Dosen, 1(1). 

Rimbawati, R., Prandika, B., & Cholish, C. (2022). Rancang Bangun Sistem Konversi 
Energi Panas Api Menjadi Energi Listrik Sebagai Alat Charger Baterai Menggunakan 
Termoelektrik. CIRCUIT: Jurnal Ilmiah Pendidikan Teknik Elektro, 6(1), 1-8. 

Rimabawati ST, M. T., & Afiza, D. (2021). Analisis Instalasi Kelistrikan Pada Wisata 
Sawah Pematang Johar (Doctoral dissertation). 

Rimbawati, R., Hutasuhuta, A. A., Evalina, N., & Cholish, C. (2018). Analysis Comparison 
Of The Voltage Drop Before And After Using The Turbine In The Bintang Asih 
Microhydro Power Plant System. Proceeding of Ocean, Mechanical and Aerospace-
Science and Engineering-, 5(1), 18-22. 

Rimbawati, R., Ardiansyah, N., & Evalina, N. (2019, May). Perancangan Sistem 
Pengontrolan Tegangan Pada Pltb Menggunakan Potensio Dc. In Seminar Nasional 
Teknik (SEMNASTEK) UISU (Vol. 2, No. 1, pp. 14-20). 

Rimbawati, R., Yusniati, Y., Cholish, C., Azis, A., & Evalina, N. (2018, June). Analisis 
Tahanan Kabel Jaringan Distribusi Tegangan Rendah Pada Pltmh Bintang Asih. 
In SEMNASTEK UISU 2018. 

Siregar, M., Evalina, N., Cholish, C., Abdullah, A., & Haq, M. Z. (2021). Analisa 
Hubungan Seri Dan Paralel Terhadap Karakteristik Solar Sel Di Kota Medan. RELE 
(Rekayasa Elektrikal dan Energi): Jurnal Teknik Elektro, 3(2), 94-100. 

Surya, H., Daut, I., & Nisja, I. (2013). EFFECT OF VOLTAGE SAG TYPES ON AC 
MOTOR DRIVE: TEST RESULTS. Journal of Environmental Research And 
Development, 7(4A), 1615. 

Suwarno, S., & Zambak, F. (2022). Optimalisasi Kecepatan Putaran Motor Listrik 
Sebagai Beban Pada PLTS 5 kWp (Aplikasi: Laboratorium Balai Besar 



Jurnal Ilmiah Mahasiswa Teknik [JIMT] 

Volume 2 Nomor 6 Juni 2022 Hal 477 - 486 

ISSN: 2808-7720 

 

486 
Jurnal Homepage: http://jurnalmahasiswa.umsu.ac.id/index.php/jimt 

Pengembangan Dan Penjamin Mutu Pendidikan Vokasi Bidang Bangunan Dan 
Listrik Medan). RELE (Rekayasa Elektrikal dan Energi): Jurnal Teknik Elektro, 5(1), 
8-15. 

Zambak, M. F. (2021). Transfer Listrik Tanpa Kabel Menggunakan Resonan Magnetik 
Koil (Vol. 1). umsu press. 

Zulfikar, Z., Aulia, C. T., & Akmal, S. (2020). Exploring Efl Students’ Problems in Listening 
To English News Broadcasts. Language Literacy: Journal of Linguistics, Literature, 
and Language Teaching, 4(2), 340-352. 

Zulfikar, Z., Evalina, N., Azis, A., & Nugraha, Y. T. (2019). Analisis Perubahan Kecepatan 
Motor Induksi 3 Phasa Dengan Menggunakan Inverter 3G3MX2. In Seminar 
Nasional Teknik (SEMNASTEK) UISU (Vol. 2, No. 1, pp. 174-177). 

Zulfikar, Z., & Aulia, C. T. (2020). Exploring Acehnese EFL College Students’ Perceptions 
on Collaborative Writing. Wanastra: Jurnal Bahasa dan Sastra, 12(2), 171-180. 

Zulfikar, Z. (2022). REDUCING EFL LEARNERS’SPEAKING ANXIETY THROUGH 
SELECTIVE ERROR CORRECTION AND GROUP-WORK STRATEGIES. ELT 
Echo: The Journal of English Language Teaching in Foreign Language 
Context, 7(1), 69-88. 

Zulfikar, Z. (2022). Reducing EFL Learners’ Speaking Anxiety through Selective Error 
Correction and Group Work. LET: Linguistics, Literature and English Teaching 
Journal, 12(1), 1-22. 

Zulfikar, Z., Evalina, N., Azis, A., & Nugraha, Y. T. (2019). Analisis Perubahan Kecepatan 
Motor Induksi 3 Phasa Dengan Menggunakan Inverter 3G3MX2. In Seminar 
Nasional Teknik (SEMNASTEK) UISU (Vol. 2, No. 1, pp. 174-177). 

 


